9.1.2 Retrieving the Export from the SAS Clinical Trial Data Transparency Portal ........................................62

10 Online Help .............................................................................................................................................65

11 Troubleshooting ......................................................................................................................................67

Appendix A: Terms of Use .............................................................................................................................68

Information about This Document

Document Control .............................................................................................................................................70
Contacts .........................................................................................................................................................70
Revision History ..............................................................................................................................................70

Figures
Figure 1: Overview ...........................................................................................................................................2
Figure 2: Welcome Email ..................................................................................................................................3
Figure 3: Account Help .....................................................................................................................................3
Figure 4: SAS Secure Access Management ....................................................................................................4
Figure 5: SAS Clinical Trial Data Transparency Portal Logon ........................................................................4
Figure 6: SAS Clinical Trial Data Transparency Portal Accept Terms (Start) ....................................................5
Figure 7: SAS Clinical Trial Data Transparency Portal Accept Terms (Finish) ....................................................5
Figure 8: SAS Clinical Trial Data Transparency Portal (Proceed to Home) .......................................................6
Figure 9: Microsoft Remote Desktop Download—“Get” Button ....................................................................7
Figure 10: Remote Desktop Configuration—Computer Name .......................................................................7
Figure 11: Remote Desktop Configuration—Advanced Tab ..............................................................................8
Figure 12: Remote Desktop Configuration—Connection Settings .................................................................8
Figure 13: Remote Desktop Configuration—Gateway Credentials ...............................................................9
Figure 14: Remote Desktop—Save Profile ......................................................................................................9
Figure 15: Remote Desktop—Additional Screen and Logon Window .............................................................10
Figure 16: Credentials Window—Password ....................................................................................................10
Figure 17: Remote Desktop Connection Security Certificate Authentication .............................................11
Figure 18: Main Terminal Server Screen ....................................................................................................11
Figure 19: Remote Desktop Connection—Experience Tab Defaults .............................................................12
Figure 20: Desktop Background When Not Refreshed ....................................................................................12
Figure 21: Remote Desktop Connection—Experience Tab Selections ...........................................................13
Figure 22: Application Window ....................................................................................................................14
Figure 23: Edit Remote Desktop Window .....................................................................................................14
Figure 24: Remote Desktop Edits ..................................................................................................................15
Figure 25: Gateway Settings ..........................................................................................................................15
Figure 26: Credentials ..................................................................................................................................16
Figure 27: New Connection ............................................................................................................................17
Figure 28: Certificate Verification ................................................................................................................17
Figure 29: Main Terminal Server Screen ....................................................................................................18
Figure 30: Logging Off the Research Environment .......................................................................................19
Figure 31: SAS Clinical Trial Data Transparency Research Environment Desktop Icons ................................20
Figure 32: SAS Clinical Trial Data Transparency—Study Folders ..................................................................23
Figure 33: Opening a SAS Data Set ..............................................................................................................24
Tables
Table 1: Common Issues .............................................................................................................. 67
1 Overview

This user guide is to be used by researchers and sponsors who are using the SAS® Clinical Trial Data Transparency system (version 2.3 and higher). A majority of this guide is directed toward researchers, since they will be the main users of the system; however, many parts also show how the sponsor can use/access the system.

Three environments or websites encompass the SAS Clinical Trial Data Transparency system:

- **SAS Secure Access Management**
  - **How to access:** Enter [https://www.ondemand.sas.com/sam/](https://www.ondemand.sas.com/sam/) from your browser for access through the Internet.
  - **Tasks you can perform:**
    - Set up your password.
    - Set up security/challenge questions.
    - Reset your password.

- **Research environment**
  - **How to access:** You will need to first set up your Secure Access Management account information before you can log on remotely (see above). Then, follow the instructions on accessing the environment through a remote desktop connection (see Section 3 [Accessing the Research Environment]).
  - **Tasks you can perform:**
    - Perform research work using PC software provided (e.g., PC-SAS, R, PLINK).
    - Collect files for export from the research environment.

- **SAS Clinical Trial Data Transparency portal**
  - **How to access:** Log on to the SAS Solutions OnDemand secure portal via [https://mseportal.ondemand.sas.com/ctdt/](https://mseportal.ondemand.sas.com/ctdt/)
  - **Tasks you can perform:**
    - Initially accept the terms of the system.
    - Import files into the research environment.
    - Receive exports from the research environment.
    - Administrators can review reporting and summary reports on activity/access.
    - Review user guides and how-to videos.

**Note:** Once you set up your password and challenge questions, you are required to accept the Terms of Use Agreement in the SAS Clinical Trial Data Transparency portal. Accepting these terms unlocks your account.
**Figure 1** provides an overview of the system.

**Figure 1: Overview**

Note: Your account information (username [or user ID] and password) enables you to access all the components of the SAS Clinical Trial Data Transparency system.
2 Setting Up Your Account

2.1 Completing the Initial Email and Password Setup

You will receive an email from SAS Solutions OnDemand with your username (or user ID) for the SAS Clinical Trial Data Transparency system. To activate the account and set up a password, click the link in the email (Figure 2).

Figure 2: Welcome Email

![Welcome Email](image)

Note: The link in the email expires after 72 hours. If you do not activate your account within 72 hours, visit the Account Help tab (Figure 3) at [https://www.ondemand.sas.com/samy/](https://www.ondemand.sas.com/samy/). Use the My password expired or I don’t know my username options. Otherwise, contact SAS Technical Support via the following:

- Email: CTDTsupport@sas.com
- URL: [http://support.sas.com/ctx/supportform/index.jsp](http://support.sas.com/ctx/supportform/index.jsp)
- North America: Call 919-677-8008

Figure 3: Account Help

![Account Help](image)
Click the link to set up a password. The Secure Access Management system guides you through the process of setting up a password (Figure 4).

**Figure 4: SAS Secure Access Management**

```
Note: The Secure Access Management system provides password rules when you set a password. Your account’s password expires after 90 days. Beginning eight days prior to your password’s expiration, you receive a daily email reminder to reset your password.

2.2 Accepting Terms in the Portal

Before you can access files and study data in the research environment, you must first accept the Terms of Use Agreement on the SAS Clinical Trial Data Transparency portal.

1. Access the SAS Clinical Trial Data Transparency portal at https://mseportal.ondemand.sas.com/ctdt/.

2. On the logon screen, enter your SAS Clinical Trial Data Transparency system user ID (or username) and password (Figure 5).

**Figure 5: SAS Clinical Trial Data Transparency Portal Logon**
3. After logon is complete, Accept Terms is the only option that displays (Figure 6). Click the Click and review this information link.

Figure 6: SAS Clinical Trial Data Transparency Portal Accept Terms (Start)

4. A PDF of terms displays. Review the text of the PDF. Once the review is complete, click Next.

5. A statement displays enabling you to accept the terms (Figure 7). Click Yes, I agree, and then click Finish.

Figure 7: SAS Clinical Trial Data Transparency Portal Accept Terms (Finish)

6. Once the statement is accepted, a confirmation displays (Figure 8). Click the Proceed to Home link to open the Home tab.

   Note: A copy of the terms accepted is available on your research access request for reference.
Figure 8: SAS Clinical Trial Data Transparency Portal (Proceed to Home)

SAS® Clinical Trial Data Transparency Portal

Home   CTDT Options  Forum

The terms acceptance was finished. This terms requirement is now met.

(Proceed to Home)
3 Accessing the Research Environment

Note: If you have not accepted the terms on the SAS Clinical Trial Data Transparency portal, you must follow those steps first. See Section 2.2 (Accepting Terms in the Portal).

The research environment is accessed via a remote desktop connection session. For Windows users, a remote desktop should be available for any version. Mac users can download the application via the Mac App Store. Once you have accessed the Mac App Store, use the search bar at the top right of the screen to search for “Microsoft Remote Desktop.” The first search result should be the one you need. To begin the download, click Get (Figure 9). This app is free, so no price will be listed.

Figure 9: Microsoft Remote Desktop Download—“Get” Button

3.1 Manually Configure Remote Desktop Session Settings

3.1.1 Windows Users

1. Access Remote Desktop from Start > All Programs > Accessories > Remote Desktop Connection. You can also type “Remote Desktop Connection” in the dialog box after you click the Start icon.

2. For Computer, enter the value CTDTProd.vsp.sas.com (Figure 10).

Figure 10: Remote Desktop Configuration—Computer Name
Note: Depending on your version of Windows, the following instructions/screenshots may not match exactly in tab/field name, although they should be very similar in intent. Any questions can be directed to SAS Technical Support.

- Email: CTDTsupport@sas.com
- URL: http://support.sas.com/ctx/supportform/index.jsp
- North America: Call 919-677-8008

3. Click **Show Options** to show all options for remote desktop connections.

4. Click the **Advanced** tab (**Figure 11**).

**Figure 11: Remote Desktop Configuration—Advanced Tab**

![Remote Desktop Configuration—Advanced Tab](image)

5. Click **Settings...** to display the connection settings (**Figure 12**).

**Figure 12: Remote Desktop Configuration—Connection Settings**

![Remote Desktop Configuration—Connection Settings](image)
6. Select the **Use these RD Gateway server settings** radio button. For the server name, enter “gatewayfact.ondemand.sas.com”. Check the **Use my RD Gateway credentials for the remote computer** checkbox (see Figure 13).

Figure 13: Remote Desktop Configuration—Gateway Credentials

![Remote Desktop Configuration](image)

7. Click **OK**, and return to the **General** tab.

8. Enter VSP\<your user ID> in the User name field. Then, click **Save As** and save the settings to an “xxx.rdp” file for later use (Figure 14).

Figure 14: Remote Desktop—Save Profile

![Remote Desktop Save Profile](image)

9. At this point, you should be able to click **Connect** to establish a connection to the terminal server. When using a newly saved rdp file, an additional logon window (Figure 15) may display prior to the remote desktop session window. In this window, be sure to check the **Don’t ask me again for connections to this computer** checkbox, and then click **Connect**.

![Remote Desktop Logon Window](image)
Figure 15: Remote Desktop—Additional Screen and Logon Window

![Remote Desktop Connection window](image)

10. You will be prompted for a username and password. Complete the sign-in process by entering the password on the subsequent screen (Figure 16).

Figure 16: Credentials Window—Password

![Credentials window](image)

11. You may be asked about the remote computer’s security certificate. This certificate comes from SAS and should be trusted. SAS recommends checking the **Don’t ask me again for connections to this computer** box (Figure 17).
12. At this point, you should be at the main terminal server screen (Figure 18).

Figure 17: Remote Desktop Connection Security Certificate Authentication

Figure 18: Main Terminal Server Screen
You may not have the blue background shown in the screenshots above. This is usually due to an extra setting you may need to set. Typically, under the Experience tab, the Choose your connection speed to optimize performance option will be set to Detect connection quality automatically (see Figure 19).

Figure 19: Remote Desktop Connection—Experience Tab Defaults

If your connection is slow, the RDC connection may not refresh the desktop background, and you will instead have a black background (see Figure 20).

Figure 20: Desktop Background When Not Refreshed
To try to rectify and get the blue background, navigate to the Experience tab and, from the drop-down menu, select **Low-speed broadband (256 kbps – 2 Mbps)**. You will then have six checkboxes to check/uncheck. Check the **Desktop background** checkbox, and then click **Connect** (see **Figure 21**).

**Figure 21: Remote Desktop Connection—Experience Tab Selections**

![Remote Desktop Connection](image.png)

### 3.1.2 Mac Users

When you get to the terminal server, you should now see the blue background. Keep in mind that this is a cosmetic item, and in no way does it interfere or prevent the user from using all SAS Clinical Trial Data Transparency terminal server environment functionality.

1. Open the application by clicking through the grey **Launchpad** icon and clicking on the **Remote Desktop** app icon: ![Remote Desktop](image.png)

   The application should open with a window like the one shown in **Figure 22**.
Figure 22: Application Window

2. Click New in the top left of the Microsoft Remote Desktop screen. You will be prompted to fill in a few fields (Figure 23).

Figure 23: Edit Remote Desktop Window

3. You will need to input the connection name and PC name. Both of these should be named “CTDTProd.vsp.sas.com” (see Figure 24).
4. Next, you will need to add the gateway. Click the drop-down menu, and select **Add**, which will display the preferences window (see **Figure 25**). The gateway name should be “CTDT MSE Prod.” The server will be “gatewayfact.ondemand.sas.com.” The username will be your VSP account that you set up earlier (i.e., “vsp\mse0xxx”). Finally, input your password, and exit this window.

**Figure 25: Gateway Settings**
5. Make sure to enter your username and password for your credentials (see Figure 26).

**Figure 26: Credentials**
6. Exit the Edit Remote Desktop window. Click on the new connection to connect to the MSE environment (see Figure 27).

Figure 27: New Connection

7. A popup window will display to ask you if you want to continue to log on. Click Continue (see Figure 28).

Figure 28: Certificate Verification
8. At this point, you should be at the main terminal server screen (Figure 29).

Figure 29: Main Terminal Server Screen

3.1.3 Logging Off (Sign Out)

To log off the research environment, navigate to Start Menu > Sign out (Figure 30).

Note: If you close the session window without logging off, this can result in a hung session. You may not be able to get back into the system unless you first contact the SAS Multi-Sponsor Environment administrator so they can free up the session cleanly, and then you log back on.
Figure 30: Logging Off the Research Environment
4 SAS Clinical Trial Data Transparency Research Environment

The SAS Clinical Trial Data Transparency research environment is where the sponsor can review what has been uploaded into the system, or where a researcher can access and analyze data using various applications such as PC-SAS, SAS® Studio, SAS® Enterprise Guide®, R, and RStudio.

4.1 Research Environment Desktop Icons

1. The research environment terminal server desktop displays various shortcut icons. Double-click on the shortcut needed to access the application that you need to analyze the data (Figure 31).

Figure 31: SAS Clinical Trial Data Transparency Research Environment Desktop Icons

2. The following is a list of the icons and their purpose:
   a. Recycle Bin—used to hold deleted files
   b. Adobe Reader—used to read PDF files
   c. Documents—goes to the user’s Documents folder; this is not seen by any other user and should only be used to temporarily hold files to review, and should be cleaned up when finished using...
d. JAGS 4.2.0—Just Another Gibbs Sampler; a program for the statistical analysis of Bayesian hierarchical models by Markov chain Monte Carlo

e. Microsoft Office Excel and Word viewer—applications for viewing (not editing) Excel spreadsheets or Word documents; use OpenOffice 4.1.2 if you need to modify these types of files

f. MSYS2 MinGW 64-bit—a complete open-source development environment and shell system; it can obtain all related toolchains and dependency packages from “MinGW-builds” and MSYS2 REPO, for compiling/building other software; it can also obtain various directly usable tools and language support and compilers such as Perl, Python, Ruby, and OpenSSL

g. OpenOffice 4.1.2—application used to open, edit, and review Word documents, RTF documents, text documents, and Excel spreadsheets; and make presentations and drawings; Microsoft Office is NOT on this system, and this application is intended to be used in place of it.

h. R i386 3.3.0 or R x64 3.3.0.—32-bit and 64-bit, respectively, R applications

i. R Studio—the R Studio application

j. PC SAS 9.4—desktop version of SAS for the PC; runs on the terminal server

k. SAS CTDT File Manager—an area containing the following:

i. Study zip files provided by the sponsor (read-only); these studies will have been downloaded to the terminal server desktop E: drive area for the research team to use (see o. Study Data below, and Section 4.2 [Study Data and Study Documents])

ii. A research project area (read-write) where you can upload files from the terminal server desktop and request exports to the SAS Clinical Trial Data Transparency portal and receive imported files from the portal

l. SAS Enterprise Guide (version 7.1)—desktop version of SAS Enterprise Guide for the PC; runs on the terminal server

m. SAS® Studio 3.6—desktop version of SAS Studio; runs on the terminal server

n. SAS Universal viewer—application to view SAS data sets

o. Study Data—shortcut to the E: drive where all research projects are kept and to where the associated studies have been downloaded; a sponsor will not be able to access any research area; a researcher will only be able to access the particular research area to which they have been granted access (they will not have permission to get into any other research area)

p. WinBUGS14—an interactive Windows version of the BUGS program for Bayesian analysis of complex statistical models using Markov chain Monte Carlo techniques; WinBUGS allows models to be described using a slightly amended version of the BUGS language, or as Doodles (graphical representations of models), which can, if desired, be translated to a text-based description

q. PLINK—open-source whole genome association analysis toolset, designed to perform a range of basic, large-scale analyses in a computationally efficient manner

4.2 Study Data and Study Documents

Study data and documentation are first uploaded to the SAS Clinical Trial Data Transparency environment by the sponsor, and then the study(s) are associated to a research area for the researcher(s) to use. The study(s) are each zipped up and can be viewed in the SAS Clinical Trial Data Transparency File Manager using the associated shortcut. The easiest way to review items and start any type of analysis is by locating the research area on the E: drive using the Study Data shortcut icon.

1. To use the SAS Clinical Trial Data Transparency File Manager, double-click the SAS CTDT File Manager shortcut, and log on as needed. The research area and various studies will display on the
left-hand side. See Section 7 (SAS Clinical Trial Data Transparency File Manager) on how to view and use the SAS Clinical Trial Data Transparency File Manager.

2. To work with the study information on the E: drive, double-click on the **Study Data** shortcut to navigate to the E: drive, where all research areas are located. Click on the research area that you have been given permission to use. You will see the zip files for all the studies that have been downloaded for you, and you will see that each zip file has been unzipped so that you can (depending on what the sponsor included in the zip file) review data sets, review various documents, and initiate your analysis using any desired tools.

3. In this same area within the research area on the E: drive, a user (or any other researcher who is a part of this research area, with the exception of a **read-only** researcher who can only review items) can make new folders to share work with others and organize things.

   **Note:** A researcher has read-write access to their research proposal folder and its subfolders, but they are denied access to other research proposal folders. Researchers and sponsors should not make permissions changes to folders.

4. **Recommended Action:** Although you can access your research area by using the **Study Data** shortcut, once you are there, you can right-click on your research area and create a shortcut on the desktop that will navigate directly to your research area. This will only be available for the researcher who created it, so other researchers within or outside of the project will not have or see the shortcut.

5. If a sponsor has used the standard folder structure for a study, then within the **Raw Datasets** folder and the **Analysis Ready Datasets** folder for each study are subfolders of **SAS_raw/R_raw** and **SAS_analysis/R_analysis** (respectively) that contain study data in SAS format (for analyzing with various SAS products) and R-ready format (comma delimited files for using with R applications). There is also an additional file for each CSV file that includes metadata describing the columns from the source SAS data set.

6. If a sponsor has used the standard folder structure for a study, then the **Documents** folder will have many other subfolders for housing items such as protocol information, SAP, and annotated CRFs.

7. There may also be other folders that contain supporting information to help you understand and navigate the data sets.

   **Figure 32** shows an example of the standard folder structure.
**Figure 32: SAS Clinical Trial Data Transparency—Study Folders**

![Study Folders Diagram]

**Best Practice:** On a research project with multiple researchers, there should be one lead researcher. This is the researcher through which all communication between the sponsor and researchers will go. The lead researcher should make any new folders/subfolder structures for team use within the research area on the E: drive. Although all researchers (lead researcher, regular researcher, and read-only researcher) can read, write, and modify items on the E: drive, it should be the lead researcher (and possibly the regular researcher[s]) who makes any new structures for the team to use. The lead researcher can also set permissions on the folders as to who can read, write, and modify items. Read-only researchers should just review things, unless there is a need for them to have their own area (for example, a quality assurance folder for review results).

### 4.3 Browsing Study Data and Documents

Your study data and documents can be accessed on the E: drive via the **Study Data** shortcut. SAS data sets are provided in the **SAS_raw** and **SAS_analysis** folders. CSV files are provided for use with R in the **R_raw** and **R_analysis** folders. The following describes an abbreviated example:

1. Go to the standard folder structure for a study, and then go into the **Raw Datasets** folder (Figure 32).

2. From within a folder, right-click the desired SAS data set (Figure 33). You can select the application you want to use to open the SAS data set. We will select **Browse with SAS 9.4**.
Figure 33: Opening a SAS Data Set

3. A view of the data set displays (Figure 34). The default program that opens the data set if the user were to just double-click on it is SAS Enterprise Guide. Review the data set:

a. SAS Explorer displays on the left-hand side.
b. Data set columns and data display on the right-hand side.
c. All PC-SAS 9.4 options display at the top of the application.
4. To sort, click a column heading, and then click the a to z icon (Figure 35).

4.4 Conducting and Saving Research

Researchers can work on the secure desktop just as they would on any type of Windows desktop. The only difference is that the **data/output cannot be copied out of the system via cut and paste, or copy and paste**. Researchers need to request an export when they are ready to export their results from the
system (see Section 9 [Exporting]). Researchers can use various applications to analyze their data, depending on what they are familiar and comfortable using. Some examples are PC-SAS, R, and PLINK.

It is recommended that researcher(s) do not make multiple copies of the data (on the E: drive or elsewhere) when doing analysis in their research area on the E: drive. The data will be located within specific areas, and programs should just point to those areas to read the data from (for example, see the SAS example using a libname statement in Figure 36).

**Figure 36: Example Path for Reading Data on the E: Drive**

```
libname studyd "E:\Research Area TEST RP-12345\ACME-12987\Files\Raw Datasets\SAS_raw";
```

If a researcher needs to save output that, for the time being, only they would like to review and have access to, they can save items to the Documents area on the D: drive under researcher userid (in other words, D:\Users\<userid>\Documents\<folder>). This path may need to be manually entered in the Windows File Manager text box (see Figure 37) depending on which application you are using when saving the file. Make sure to clean up the files that are put there when the research project is completed. See Figure 38.

**Figure 37: Manually entering path to save items to the Researcher’s Area on the D: Drive**

![Image of Windows File Manager]

**Figure 38: Example Path for Saving Items to the Researcher’s Area on the D: Drive**

```
libname mystudyd "D:\Users\<userid>\Documents\My Study data";
```

If a researcher needs to save output that the team would like to review and access, they can save items to a designated area on the E: drive research area (see Figure 39).

**Figure 39: Example Path for Saving Items on the E: Drive for the Research Team to Access**

```
libname teamoutput "E:\Research Area TEST RP-12345\output";
```
5 Using SAS

In the SAS Clinical Trial Data Transparency research environment, a researcher can access and analyze their data using various SAS applications such as PC-SAS, SAS Studio, and SAS Enterprise Guide.

5.1 Running SAS

This section provides information to enable you to run SAS within the SAS Clinical Trial Data Transparency research environment. SAS programs can be run in PC-SAS 9.4, SAS Enterprise Guide 7.1, or SAS Studio 3.6.

Use one of the following methods to open a SAS session:

- From the terminal server desktop, choose the application shortcut you wish to use. Double-click the corresponding icon.

- Right-click a SAS program, and choose the application you wish to use to open the program (note that SAS Studio is not a menu option when right-clicking).

Write a new SAS program (using any of the SAS products available) in an empty Editor window, or modify an existing SAS program that you opened. Click the Submit or Run icon on the toolbar to run the program in the active Editor window and review the log within the Log window. A section of code can be run by highlighting it first and clicking the Submit or Run icon.

Once you have your program running to your satisfaction, save it by following these steps:

1. In PC-SAS, click the Save icon on the toolbar, or click File > Save or Save As. In SAS Enterprise Guide, click on File > Save Project or Save Project As. In SAS Studio, click on the Save Program or Save As icon.

2. Navigate to the location within the Study Data E: drive research area folder where you want to save your program. Researchers can also navigate to an area on the D: drive if they wish to save their work there.

3. Supply a name for your program.

4. Click Save.

5.2 Producing Graphical Results

Using the SAS Output Delivery System, you can produce graphical results.

The following is a sample program:

```sas
Libname testlib “C:/CTDT/CTDT RP-12345/Files data/”;
ods PDF file="C:/CTDT/CTDT RP-12345/Files/output/myoutput.pdf";
Proc means data=testlib.AE;
Run;
ods PDF Close;
```
The SAS Output Delivery System provides instructions to SAS for producing a variety of different formats of output, such as PDF, RTF, and HTML. In the example, all output produced by steps starting at `ods PDF file=...;` up to the `ods PDF close;` statement are sent to a PDF file (Figure 40).


Figure 40: PDF Output

```
Note: See Section 4.4 (Conducting and Saving Research) for examples of how to set up paths for reading data or writing data/output.
```
6  Using R

6.1  Overview

This section provides information on transferring (or downloading) files from the SAS Clinical Trial Data Transparency File Manager to your working area on the terminal server so you can use them in R. It also describes the R packages that are available and how additional R packages can be imported and used.

The general concept is:

1. Studies are automatically downloaded for the researcher(s) to their designated research area on the E: drive. However, if needed, the researcher can re-download the study zip files. To do this, download the study zip file from the SAS Clinical Trial Data Transparency File Manager to your Study Data folder research area on the E: drive via instructions in Section 4.4 (Conducting and Saving Research). When you unzip the file on the E: drive on the terminal server, you will have at least three folders, one of which will be the RAW Datasets folder, and one will be the Analysis Ready Datasets folder. The needed CSV files will be in the Raw Datasets/R_raw folder or in the Analysis Ready Datasets/ R_analysis folder (Figure 41).

Figure 41: CSV Files (R_raw and R_analysis)
2. Run R programs on the relevant files. R version 3.3.0 is currently installed on the terminal server along with various R packages.

3. You can import and then use other R packages as needed by using the import functionality in Section 8 (Importing).

4. Upload files and results back to your SAS Clinical Trial Data Transparency File Manager research area.

5. Move files to the exports folder in your research area to export them from the research environment (see Section 9 [Exporting]).

6. To access R, double-click the appropriate R icon on the desktop of the research environment (Figure 42).
Figure 42: R Desktop Icon
The R startup screen displays *(Figure 43).*

**Figure 43: R Startup Screen**

6.1.1 Accessing RStudio

To access RStudio, double-click the **RStudio** icon in the research environment *(Figure 44).*
Figure 44: RStudio Desktop Icon
The RStudio startup screen displays (Figure 45).

Figure 45: RStudio Startup Screen

Figure 46 shows an example of reading in a CSV file saved locally.

Figure 46: Locally Saved CSV File

```r
> AE <- read.table("C:/Users/[username]/Documents/r_analysis_dataset/ae_small.csv", sep="", header=TRUE)
```

This opens the RStudio view with browsing ability (Figure 47).

Figure 47: RStudio View
6.2 Retrieving Files for Use

1. Once a user has logged on to the SAS Clinical Trial Data Transparency terminal server using their system account, they will be able to access at least the following three folders in their designated E: drive research area: Analysis Ready Datasets, Documents, and Raw Datasets. The Analysis Ready Datasets and Raw Datasets folders both have subfolders that contain R CSV files that are to be used for analysis.

2. Navigate to the R files you wish to use, either the R_raw CSV files or the R_analysis CSV files. From here, you can double-click a file to open it in OpenOffice (default), or right-click a file and choose the program you want to use to open the file.

3. Note the path to these files in order to use them in R and RStudio.

6.3 Using R and RStudio

6.3.1 Overview

Using R and RStudio in the research environment is very similar to using R on your local PC. R (console) 32-bit (R i386 3.3.0) and 64-bit (R x64 3.3.0) versions and RStudio 64-bit (version 3.3.0) are provided. Figure 48 shows an example of the package list from RStudio within the SAS Clinical Trial Data Transparency terminal server.

Note: Your installation may include later versions of packages and/or additional base packages. Additional R packages can be imported as described in Section 6.3.2 (Importing Additional R Packages). Also, some packages do not run without additional needed software. Unfortunately, at this time, SAS will not put additional software on the research environment server. Contact SAS Technical Support with any software issues:

- Email: CTDTsupport@sas.com
- URL: http://support.sas.com/ctx/supportform/index.jsp
- North America: Call 919-677-8008
### Figure 48: RStudio List of R Packages

<table>
<thead>
<tr>
<th>Package</th>
<th>Description</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>base</td>
<td>Functions for classification</td>
<td>3.3-14</td>
</tr>
<tr>
<td>class</td>
<td>'Fitting Groups in Data': Cluster Analysis Extended Roux et al.</td>
<td>2.0.4</td>
</tr>
<tr>
<td>codetools</td>
<td>Code Analysis Tools for R</td>
<td>0.2-14</td>
</tr>
<tr>
<td>compiler</td>
<td>The R Compiler Package</td>
<td>3.3.0</td>
</tr>
<tr>
<td>datasets</td>
<td>The R Datasets Package</td>
<td>3.3.0</td>
</tr>
<tr>
<td>foreign</td>
<td>Read Data Stored by Minitab, S, SAS, SPSS, Stata, Systat, Weka, dBase, ...</td>
<td>0.8-66</td>
</tr>
<tr>
<td>graphics</td>
<td>The R Graphics Package</td>
<td>3.3.0</td>
</tr>
<tr>
<td>grid</td>
<td>The Grid Graphics Package</td>
<td>3.3.0</td>
</tr>
<tr>
<td>lattice</td>
<td>Trellis Graphics for R</td>
<td>0.20-33</td>
</tr>
<tr>
<td>manipulate</td>
<td>Interactive Plots for RStudio</td>
<td>0.98.107</td>
</tr>
<tr>
<td>MASS</td>
<td>Support Functions and Datasets for Multivariate Analysis: R Package for Venables &amp; Ripley's MASS</td>
<td>7.3-45</td>
</tr>
<tr>
<td>Matrix</td>
<td>Sparse and Dense Matrix Classes and Methods</td>
<td>1.2-6</td>
</tr>
<tr>
<td>methods</td>
<td>Formal Methods and Classes</td>
<td>3.3.0</td>
</tr>
<tr>
<td>mgcv</td>
<td>Mixed GAM Computation Vehicle with GCV/AIC/REML Smoothness Estimation</td>
<td>1.8-12</td>
</tr>
<tr>
<td>nlmix</td>
<td>Linear and Nonlinear Mixed Effects Models</td>
<td>3.1-127</td>
</tr>
<tr>
<td>nnet</td>
<td>Feed-Forward Neural Networks and Multinomial Log-Linear Models</td>
<td>7.3-12</td>
</tr>
<tr>
<td>parallel</td>
<td>Support for Parallel computation in R</td>
<td>3.3.0</td>
</tr>
<tr>
<td>gplots</td>
<td>Recursive Partitioning and Regression Trees</td>
<td>4.1-10</td>
</tr>
<tr>
<td>rgl</td>
<td>Tools and Utilities for RStudio</td>
<td>0.98.107</td>
</tr>
<tr>
<td>spatstat</td>
<td>Functions for Kriging and Point Pattern Analysis</td>
<td>7.3-11</td>
</tr>
<tr>
<td>splines</td>
<td>Regression Spline Functions and Classes</td>
<td>3.3.0</td>
</tr>
<tr>
<td>stats</td>
<td>The R Stats Package</td>
<td>3.3.0</td>
</tr>
<tr>
<td>stats4</td>
<td>Statistical Functions using S4 Classes</td>
<td>3.3.0</td>
</tr>
<tr>
<td>survival</td>
<td>Survival Analysis</td>
<td>2.39-2</td>
</tr>
<tr>
<td>tcltk</td>
<td>Tcl/Tk Interface</td>
<td>3.3.0</td>
</tr>
<tr>
<td>tools</td>
<td>Tools for Package Development</td>
<td>3.3.0</td>
</tr>
<tr>
<td>translations</td>
<td>The R Translations Package</td>
<td>3.3.0</td>
</tr>
<tr>
<td>usbl</td>
<td>The R Usb Package</td>
<td>3.3.0</td>
</tr>
</tbody>
</table>
6.3.2 Importing Additional R Packages

Follow the steps below to add R packages that are not provided in the research environment.

1. Import R packages to the SAS Clinical Trial Data Transparency terminal server research environment using the Import function via the Clinical Trial Data Transparency portal (see Section 8.1 [Imports]).

2. Download the package from the SAS Clinical Trial Data Transparency imports folder using the following steps:
   a. Navigate to the imports folder in the SAS Clinical Trial Data Transparency File Manager, and download the appropriate file(s) to the researcher’s designated area on the D: drive. The researcher will need to type this in as “D:/Users/<mse0xxx>/Documents/R/win-library/3.3/<foldername>”.
   b. Open R from the research environment terminal server, and execute the following command:

      ```
      install.packages("[local file reference]", repos=NULL, lib=.libPaths()[1])
      ```

      This command installs the package(s) in the referenced zip file in the local path, that path being the one noted in part “a” above.

      The following example installs the survival package when the package has been placed in the D:/Users/<mse0xxx>/Documents/R/win-library/3.3/newpackages folder:

      ```
      install.packages("D:/Users/<user ID>/Documents/R/win-library/3.3/newpackages/survival_2.37-4.zip", repos=NULL, lib=.libPaths()[1])
      ```

   c. The installation of the module can be confirmed by using the following command:

      ```
      installed.packages() and/or require (packagename).
      ```
6.3.3 Accessing R

To access R, double-click the appropriate R icon on the desktop of the research environment (Figure 49).

Figure 49: R Desktop Icon
The R startup screen displays (Figure 50).

Figure 50: R Startup Screen

```
R version 3.3.0 (2016-05-03) -- "Supposedly Educational"
Copyright (C) 2016 The R Foundation for Statistical Computing
Platform: x86_64-w64-mingw32/x64 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()', 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

> |
```

6.3.4 Accessing RStudio

To access RStudio, double-click the RStudio icon in the research environment (Figure 51).

Figure 51: RStudio Desktop Icon
The RStudio startup screen displays (Figure 52).

**Figure 52: RStudio Startup Screen**

![RStudio Startup Screen](image-url)

To learn more and/or disable this warning message see the "use secure down load method for https" option in tools -> global options -> packages.

---

**Figure 53** shows an example of reading in a CSV file saved locally.

**Figure 53: Locally Saved CSV File**

```
> AE <- read.table("C:/Users/username/Documents/r_analysis_dataset/ae_small.csv", sep="", header=TRUE)
```

This opens the RStudio view with browsing ability (Figure 54).

**Figure 54: RStudio View**

![RStudio View](image-url)
7  SAS Clinical Trial Data Transparency File Manager

The SAS Clinical Trial Data Transparency File Manager allows a researcher to request an export of their final results, and it also allows a researcher to review imports and/or download imported files to the terminal server. It holds read-only study zip files (provided by sponsors) that have been downloaded and unzipped on the desktop E: drive (accessed via the Study Date desktop shortcut icon) for your use.

**Note:** Although exports are requested from the SAS Clinical Trial Data Transparency File Manager, the actual export.zip file (when approval is given by sponsors[s]) is obtained via the SAS Clinical Trial Data Transparency portal.

7.1  Logging On

1. In the research environment, double-click the **SAS CTDT File Manager shortcut** icon ([Figure 55](#)).

   **Figure 55:** SAS Clinical Trial Data Transparency File Manager Icon

2. Internet Explorer opens, and the SAS Clinical Trial Data Transparency File Manager Logon screen displays ([Figure 56](#)). The first time you navigate to the File Manager, you will be required to enter
your user ID and/or password. You will also need to log in if you are idle in the Clinical Trial Data Transparency File Manager for 30 minutes or more.

**Figure 56: SAS Clinical Trial Data Transparency Logon Screen**

![SAS Clinical Trial Data Transparency Logon Screen](image)

3. The SAS Clinical Trial Data Transparency File Manager screen displays the **File Manager** tab (**Figure 57**), where a researcher can see their research area and the studies to which they have access. A sponsor would just see the various studies they have uploaded in the environment. Clicking on the **Home** tab shows some contents of the system (**Figure 58**).

**Figure 57: SAS Clinical Trial Data Transparency File Manager Home Tab Screen**

![SAS Clinical Trial Data Transparency File Manager Home Tab Screen](image)
7.2 Organizing Tabs

The SAS Clinical Trial Data Transparency File Manager uses a tab-based interface. The tabs include the following (depending on if you are a researcher, sponsor, or SAS Administrator):

- **Home**: This is where announcements are posted, information about user access is shown, and two graph areas show export request status and import request status (see Figure 59). There is an Options drop-down menu with a few options for things you can do in the File Manager:
  - File Manager Home (takes you to the File Manager tab)
  - File Manager Summary reports
  - File Manager Exports/Imports/Help
  - Force Log out (for the rare time when the application has been inactive for 30 minutes, and the user needs to log off and log back on to continue working)

Figure 59: File Manager Home

- **File Manager**: This is the location of the study data (in zipped form) for your research and the location of your research project area where you upload your work (usually your final analyses) from the E: drive research area to make files available for export. Items that a researcher has imported via
the SAS Clinical Trial Data Transparency portal are located here in the import folder. Study data is automatically downloaded from here to the designated research area on the E: drive so that the researcher(s) can do their analysis. There is an Options drop-down menu with a few options for things you can do from within the File Manager tab (see Figure 60):

- File Manager Home
- Exports/Imports/Help

**Figure 60: File Manager Options**

- **Terms:** If a user has not yet accepted the terms, this is where a user must click and review the SAS Clinical Trial Data Transparency Terms of Use PDF and agree to the system terms of use.

### 7.3 Accessing the SAS Clinical Trial Data Transparency Repository User Guide

The Help hyperlink on the upper right-hand side of the webpage (Figure 61) provides a link to all of the user guides and videos that a user can reference when working with various aspects of the SAS Clinical Trial Data Transparency portal and file manager. The Help tab will not display until after the Help link is clicked.

**Note:** The new videos and user guides, as well as the links to them, are currently not set up. These will be coming soon. However, the new user guide will be available to give to the researchers so they can use/reference it as needed when accessing the new environment.

**Figure 61: SAS Clinical Trial Data Transparency—Help Tab**
7.4 Accessing Data/Working on the File Manager Tab

On the File Manager tab (see Figure 62), the user will see folders that contain their research project area and the studies they can access.

![SAS Clinical Trial Data Transparency File Manager — File Manager Tab](image)

**Note:** The folder structure might be different from your research project area. Do not change the folder names imports or exports. If you change these names, you can no longer import files into or export files from the SAS Clinical Trial Data Transparency repository.

**Note:** To expand the folders, click the Expand icon: ![Expand Icon]. Study data can be viewed here (by temporarily opening the zip file), but it is also available on your desktop for use in your analyses (see Section 4.2 [Study Data and Study Documents]).

- **Research Project**
  - If you are assigned Lead Researcher or Researcher role on the project, you can add/delete folder(s), request an export, add files, and delete files.
  - If you are assigned the Researcher Read-Only role on the project, you can review items in the research area, but you cannot delete items nor request exports.
• To export files from the research environment, you must add them to the research project’s export folder. See Section 9.1 (Exports) on how to set up and request and export from the system.

- Sponsors DO NOT have permission to see the research area. Only researchers will see that area in addition to the studies.

- **Studies**

  - These are the clinical studies available for use, according to your Data Sharing Agreement.
  - As a researcher, you have read-only permissions. You cannot add, modify, or delete files from a study.
  - As a researcher, if you plan to run SAS, the data has already been downloaded for you and can be accessed on the desktop E: drive (via the **Study Date** desktop shortcut icon). See Section 4.2 (**Study Data and Study Documents**).

    **Note:** Although you will see various research areas on the E: drive, you are only allowed to work in the designated research folder you were assigned. You are denied access to all other folders. From there, you can use PC-SAS, SAS Enterprise Guide, SAS Studio, or any other application that is a part of the environment. SAS data sets are located in the **Raw Datasets** folder under the subfolder **SAS_raw** or the **Analysis Ready Datasets** folder under the subfolder **SAS_analysis**.

  - As a researcher, if you plan to run R, use the CSV files that were produced when the study was uploaded. They will be in the **Raw Datasets** folder, under the subfolder **R_raw**, or in the **Analysis Ready Datasets** folder under the subfolder **R_analysis**.
  - As a sponsor, you have read/write permissions. You can modify and delete files or folders.

**Figure 63** shows an example of a standard folder structure.
Figure 63: SAS Clinical Trial Data Transparency—Study Folders

Figure 64 shows five sample studies as well as an expanded view of an example research project area (Research Project RA-TSTAWS-12367). Users assigned the Researcher or Lead Researcher role have full permissions to create, modify, and delete folders and files within the research project area.

Figure 64: SAS Clinical Trial Data Transparency—Research Area Folders
To add a folder (if needed), select **Add Folder** from the drop-down menu (see **Figure 65**). Name the folder and give it a description. Click **Add**, and the folder will display.

**Figure 65: SAS Clinical Trial Data Transparency—Adding a Folder**

![SAS Clinical Trial Data Transparency File Manager](image1)

![SAS Clinical Trial Data Transparency File Manager](image2)
The imports folder is important and should not be changed or removed. To bring files and supporting programs into the research environment, you must import them to this location via the SAS Clinical Trial Data Transparency MSE portal. See Section 8 (Importing) for details on importing.

The exports folder is also important and it, too, should not be changed or removed. To remove final research files/documents from the research environment, you must collect them here and then make an Export Request within the SAS Clinical Trial Data Transparency File Manager. See Section 9 (Exporting) for details on exporting.

7.5 Downloading Imported Files from the SAS Clinical Trial Data Transparency File Manager to the Desktop

If a researcher wants to use files that they have imported into the system (typically programs that they use to analyze data), they can download the files from the SAS Clinical Trial Data Transparency File Manager import folder to the E: drive via the following steps:

1. On the File Manager tab, choose the import folder within the research area. A list of files that have been imported via requests in the SAS Clinical Trial Data Transparency portal (see Section 8 [Importing]) will be shown (Figure 66).
2. Click on the download arrow next to the file you wish to download (Figure 67).

3. A popup bar displays at the bottom of the screen. Choose Save As, and select the area within the research project to which you want to save the imported file. Currently, you must download each file individually that you wish to use as part of your research area on the E: drive.
7.6 Uploading Files and Results from the Desktop to the SAS Clinical Trial Data Transparency File Manager for Exporting

Results or files saved in the E: drive research area are not immediately available to export from the research environment. You must upload the files into the SAS Clinical Trial Data Transparency File Manager area. Then, in the SAS Clinical Trial Data Transparency File Manager, the researcher makes an export request. Once approved, the export can be downloaded from within the SAS Clinical Trial Data Transparency portal.

1. Consider zipping the files before transferring them to SAS Clinical Trial Data Transparency File Manager area.

2. Open the SAS Clinical Trial Data Transparency File Manager, and navigate to the `exports` folder in the research area (see Figure 68).

Figure 68: Exports Folder

3. From the drop-down menu, select **Upload New Files** or **Upload/Expand New Files** (see Figure 69).

Figure 69: Upload New Files from the File Manager
4. Select **Browse**, and navigate to the research area where the file(s) the user wants to upload are located. Choose the file you want to upload, and click **Open**. (Note: Currently, you can only upload one file at a time, so the researcher may want to first zip up multiple files into one zip file, and then upload that zip file). You can version the file if needed, and you can also add a description.

**Figure 70: Browse Files**

5. Click the **Upload** button in the File Manager. The file will now be located within the export folder, and a message in the upper right-hand corner will display a file uploaded comment.
Figure 71: Upload Files

6. At this point, you are ready to queue an export from the research environment. For more details, see Section 9 (Exporting).

Note: There are several rules regulating what can and cannot be exported from the research environment. If any files for export do not meet these rules or criteria, your export request requires approval before downloading to your computer. For details, see Section 9.1.2 (Retrieving the Export from the SAS Clinical Trial Data Transparency Portal). Every sponsor company involved in your research is required to grant approval.
8 Importing

To import file(s) into the SAS Clinical Trial Data Transparency environment, you must go through the SAS Clinical Trial Data Transparency portal. Researcher requests the import there, and when the import is done, the research will see and be able to use the file(s) imported within the SAS Clinical Trial Data Transparency File Manager, in the import folder of the research area.

1. Connect to the SAS Clinical Trial Data Transparency portal at https://mseportal.on-demand.sas.com/ctdt/.

2. On the logon screen, enter your SAS Clinical Trial Data Transparency system user ID (or username) and password (Figure 72).

   Figure 72: SAS Clinical Trial Data Transparency Portal Logon

3. The SAS Clinical Trial Data Transparency portal opens (Figure 73).

   Figure 73: SAS Clinical Trial Data Transparency Portal after Logon

8.1 Imports

8.1.1 Adding/Starting a Request

1. After logging on to the SAS Clinical Trial Data Transparency portal, click the CDTT Options tab (Figure 74).
2. Click **Imports: Show List**.

   *Note:* The **Home > Options** drop-down menu also allows direct access to options.

3. To initiate an import, do one of the following:
   a. Click **Add** on the far right-hand side of the screen:
   -or-
   b. From the **Home tab > Options** drop-down menu (Figure 75), click **Imports: Add Request**.

4. Enter a reason for the import (required). To import files you have previously imported, choose the **Overwrite/Version Existing** option to ensure that the files replace existing ones in the research environment (Figure 76).

5. Click **Add** (Figure 76).

6. The detail view displays (Figure 77) with the following options, allowing you to make required updates:
   a. The **Import Request** pane on the left-hand side of the screen displays the following:
      i. The details entered on the previous screen, including **ID**, **User**, and **Summary/Details**.
      ii. The **Status** field shows that your import request is automatically approved to start.
      iii. The **Deleted** check box is blank. This field is used for mistakenly added requests. Check this box to delete the request. The request then displays with the strikethrough text in your SAS Clinical Trial Data Transparency imports list.
   b. The **History** of the import displays at the bottom of the screen.
   c. The **Attached Files** pane on the right-hand side of the screen displays a list of the files you intend to import. The **Attach Files** hyperlink allows you to add files to your import request.
7. Click **Attach File(s)** (Figure 77).

Figure 77: Detail View

8. A dialog displays that allows you to browse for and select a file, and to identify the target location for the imported file in SAS Clinical Trial Data Transparency (Figure 78).
   a. Click **Browse**, and navigate to the desired file.
   b. Select the file, and click **Open**.
   c. The file name displays in the **File**: text box. Select a target location from the drop-down menu of research areas to which you have access.
   d. Click **Attach** to add the selected file to the import request. The **File**: text box is cleared when the upload is complete.
   e. Click **Browse**: again to add an additional file.

Figure 78: Add File(s)
9. Click **Back to Import Request** in the Attach Files panel on the left-hand side. The files you selected are listed (Figure 79).

**Figure 79: Attached Files**

<table>
<thead>
<tr>
<th>File</th>
<th>Date</th>
<th>Settings?</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>class.wax/Trial</td>
<td>1/26/17 15:21:09 EDT</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>sas.wax/Trial</td>
<td>1/26/17 15:21:09 EDT</td>
<td>✔️</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Your files have **not** been imported to the relevant SAS Clinical Trial Data Transparency File Manager **imports** folder at this point. They have only been attached to the **Import Request**. The next section covers the final steps in the import process.

### 8.1.2 Starting the Import

1. From the Import Request screen, go to the bottom of the Import Request box.
2. Click **Start Import Run** (Figure 80).

**Figure 80: Start Import Run**

3. A confirmation displays. Click **Yes** to place your import in the queue to run.
4. Once the import completes (within a few minutes), a manual refresh of the screen (Figure 81) shows that:
   a. The Import Request status has changed to **Import Processed**.
   b. An import summary file is attached to the request.
   c. An import summary displays in the History panel.

**Figure 81: Import Summary**

5. Your files are now available in the SAS Clinical Trial Data Transparency File Manager (in the **imports** folder of the research area to which the researcher has access). Go to the research environment.
(see Section 7.5 [Downloading Imported Files from the SAS Clinical Trial Data Transparency File Manager to the Desktop]) to work with the files (Figure 82).

Figure 82: Imports Folder

![SAS Clinical Trial Data Transparency File Manager](image)

**Note:** Once an import request is run, no more files can be added to the request. A new request must be created to import more files.
9 Exporting

To export files from the SAS Clinical Trial Data Transparency environment (version 2 of the system), you must request the export from within the SAS Clinical Trial Data Transparency File Manager, and then, when approved, download the requested export zip file from within the SAS Clinical Trial Data Transparency portal.


2. On the logon screen, enter your SAS Clinical Trial Data Transparency system user ID (or username) and password (Figure 83).

Figure 83: SAS Clinical Trial Data Transparency Portal Logon

3. The SAS Clinical Trial Data Transparency portal opens (Figure 84).

Figure 84: SAS Clinical Trial Data Transparency Portal after Logon

9.1 Exports

Researchers cannot export study data, patient-level data, or data sets from the system. They should export their final results of their analyses only (typically this is a PDF or RTF file). There are controls in place to prevent researchers from downloading the various study data provided to their computer. These controls further protect research participants’ privacy and confidentiality, and help ensure that the data is used for the agreed research purpose.
9.1.1 Adding a Request

1. After logging on to the SAS Clinical Trial Data Transparency File Manager, click on the exports folder. The file(s) the researcher wants to export should be shown.

   **Note:** The first version of the new SAS Clinical Trial Data Transparency system will have any items in the recycle bin also a part of the export request. This will be fixed for the next release. The workaround is to first permanently delete the file[s] in the recycle bin). From the drop-down menu, select Export Request: Add (see Figure 85).

   Figure 85: Add an Export Request

2. The Add Export Request panel displays with all the files listed that will be exported. The researcher needs to give a reason for the request (mandatory). Then, click Add (see Figure 86).

   Figure 86: Add Reason for File Export

3. The researcher will navigate to the list of all exports, with the newest request listed at the top with a status of (export run in progress). An email will be sent stating the export was requested. When the
request is processed, the request will be approved, denied, or held for sponsor review. If the request is held for sponsor review, the sponsor will approve or deny the export request. An email is sent to identify the state of the request.

a. If approved, the email will say the request has been approved and the researcher can go to the SAS Clinical Trial Data Transparency portal to get the export (see Section 9.1.2 [Retrieving the Export from the SAS Clinical Trial Data Transparency Portal]).

b. If denied, the email should state that the “Export failed one or more rules for immediate viewing” and “An administrator from the company...should review the export request and either approve or deny the export.” The researcher will have a chance to fix any issues and then make another request.

c. If the request is held for sponsor review, the email should state why the request was held and that the sponsor(s) will need to review to see if they will either let the request be approved, or deny the request with a reason for the denial so that the researcher has a chance to fix any issues and then make another request.

9.1.2 Retrieving the Export from the SAS Clinical Trial Data Transparency Portal

1. Log on to the SAS Clinical Trial Data Transparency portal, and go to the Exports: Show List selection. This is either accessed from the drop-down menu or the hyperlink (see Figure 87).

   Figure 87: Exports—Show List

2. Select the hyperlink for the export that was successful. The status of the export should be highlighted in green. You should then be able to go to the Generated Exports area and click on the blue hyperlinked zip file to download to your PC. You are required to re-enter your user ID and password to download the file.
3. There are other statuses that could be listed for the export:

   a. **New**: new export request

   b. **Approved to Start**: export request in progress

   c. **Export Created/Approved for View**: export can be viewed and downloaded from the system

   d. **Export Created/Approval Required for View**: export needs to first be reviewed by sponsor(s)

   e. **Export Denied**: an export can be denied by a sponsor(s) (and a comment should be given as to why the export was denied so a researcher has the opportunity to fix the issue); an export can be denied (temporarily) due to the fact that one or more sponsors need to manually give their approval/denial; an export will be denied (temporarily) if it failed one or more of the business rules, in which case the sponsor(s) will need to review and manually give their approval/denial

   f. **Errors in Run**: there was an issue with the export
g. **On hold**: export on hold pending review by sponsor or SAS Multi-Sponsor Environment administrator

h. **Clarification needed**: export on hold pending informational request

*Note:* Researchers typically get faster approval when they do not trigger any of the rules listed in item #3 above. Researchers should ensure that they do not add files with extensions such as .sas, .sas7bdat, .R, or .CSV. Requests will most likely be approved faster (and sometimes automatically) if the document is converted to PDF, RTF, or HTML.
10 Online Help

Online help is available in the terminal server and on the SAS Clinical Trial Data Transparency portal.

**Note:** The folder will be available on the environment, but the videos and user guide may not be in it yet as of when the researchers are doing user acceptance testing in the system.


2. From the research environment desktop, open the **Help and User Guide** folder ([Figure 89](#)).

   Figure 89: Help and User Guide Desktop Icon

   ![Help and User Guide Desktop Icon](image)

   - **-or-**

   From the SAS Clinical Trial Data Transparency portal, click **Help** at the top of the screen ([Figure 90](#)).

   Figure 90: Help Link

   ![Help Link](image)

3. The SAS Clinical Trial Data Transparency portal Help screen displays guides and how-to videos ([Figure 91](#)). To access them, click **View**.

   Figure 91: Help Screen

   ![Help Screen](image)
Note: For help related to the SAS Clinical Trial Data Transparency system, you can also contact SAS Technical Support as follows:

- Email: CTDTsupport@sas.com
- URL: http://support.sas.com/ctx/supportform/index.jsp
- North America: Call 919-677-8008
# 11 Troubleshooting

Table 1 provides a quick reference for troubleshooting the most common issues.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Steps to Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trouble connecting to the research environment (terminal server session)</td>
<td>• Verify that you have performed all steps of the one-time setup of your Secure Access Management access credential ID.</td>
</tr>
<tr>
<td></td>
<td>• Verify that your account is not locked out, by clicking <strong>My account is locked</strong> in the problem menu under the Account Help tab at <a href="https://www.ondemand.sas.com/sam">https://www.ondemand.sas.com/sam</a>.</td>
</tr>
<tr>
<td>Lost password or account information</td>
<td>• Visit <a href="https://www.ondemand.sas.com/sam">https://www.ondemand.sas.com/sam</a>.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Account Help</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Select an appropriate problem in the menu under the Account Help tab.</td>
</tr>
<tr>
<td>Account is locked</td>
<td>Contact SAS Technical Support as follows:</td>
</tr>
<tr>
<td></td>
<td>• Email: <a href="mailto:CTDTsupport@sas.com">CTDTsupport@sas.com</a></td>
</tr>
<tr>
<td></td>
<td>• URL: <a href="http://support.sas.com/ctx/supportform/index.jsp">http://support.sas.com/ctx/supportform/index.jsp</a></td>
</tr>
<tr>
<td></td>
<td>• North America: Call 919-677-8008</td>
</tr>
<tr>
<td>Trouble viewing how-to videos in the Windows Media Player</td>
<td>QuickTime is the recommended media player to use when viewing the SAS Clinical Trials Data Transparency how-to videos. Using the Windows Media Player to view the videos hosted on the SAS Clinical Trials Data Transparency portal can sometimes result in short (one second or less) distortions in the visual display during the playback of some of the videos. Distortions in the visual display do not occur when the videos are viewed with QuickTime. If Windows Media Player is the user’s default media player, the user may download the video and play it locally on their computer using a different media player. The videos might start and stop intermittently if the user is attempting to view them while using a slow Internet connection. If the user experiences viewing problems to the point that the video is unwatchable, the user may download the video and play it locally on their computer. To download the how-to video to their local computer, the user should right click <strong>View</strong>, then click <strong>Save target as...</strong> The user will then be prompted for a location to save the video. After downloading the video, the user may use any media player they have installed on their local computer to view the video. QuickTime is available for download at <a href="https://www.apple.com/quicktime/download/">https://www.apple.com/quicktime/download/</a>.</td>
</tr>
</tbody>
</table>
Appendix A: Terms of Use

The Usage Rules detailed below apply to any Researcher who is given access to sponsor data via this Clinical Trial Data Transparency Portal (“access system”). Use of sponsor data within this system must adhere to these usage rules and must also be in adherence with the signed Data Sharing Agreement (DSA) or Data Use Agreement (DUA) (hereinafter referred to as DSA) between the Sponsor(s) who provided access to the data and the lead Researcher and/or their research institution.

The secure data access system is a hosted environment managed by the Access System Manager (SAS Institute Inc., located at SAS Campus Drive, Cary, North Carolina 27513). These Usage Rules are being provided to you by the Sponsor(s) who have granted access to their study data. Researcher may not assign its rights or obligations as set forth in these Usage Rules. Sponsor or Access System Manager may limit or terminate a Researcher’s access to the Access System and/or pursue other legal action available to either of them in the event of Researcher’s noncompliance with these Usage Rules. As needed, these Usage Rules shall be interpreted and governed exclusively by the laws and the jurisdiction of the competent courts of the country/government agreed to in the DSA for a given project.

By clicking the “Accept” button, you confirm that you have reviewed and understand these Usage Rules and the approved DSA(s) for your project(s), and agree to comply with them.

Access System and Software Terms of Use

1. Researcher shall not utilize the Access System in violation of any applicable laws or regulations or for any purpose other than legitimate approved research in line with the DSA. This includes (but is not limited to) the following:
   a. sending unsolicited marketing material or communications in any form (commonly referred to as "SPAM") or sending or transmit harassing, abusive, libelous, or obscene materials or assist in any similar related activities; or
   b. engaging in any activities or actions that infringe or misappropriate the intellectual property rights of others (including but not limited to the Sponsor, the Access System Manager, or their affiliates); or

2. Researcher shall not misuse or abuse the Access System or third-party property (including, without limitation, software, equipment, networks, and network devices); or make any unauthorized use of or interfere with any property of the Access System Manager or any customers of the Access System Manager; or impair or disrupt any connections to the Access System; or upload any software or application(s) to the Access System except as expressly allowed subject to these Usage Rules or the DSA.

3. United States export laws and regulations apply to the Access System. Researcher agrees to comply with these and other applicable export and import laws and regulations. This includes but is not limited to attesting that the researcher is not located in, under control of, or a national or resident of any country or region to which export of SAS software or the System is restricted by laws of the United States or other applicable laws and regulations,
4. Researcher shall not allow any unauthorized person to have access to the Access System or the passwords or access credentials provided to the Researcher that will allow admission to the Access System (collectively “Passwords”). Researcher shall be responsible for maintaining the confidentiality of such Passwords, and shall notify Access System Manager and Sponsor immediately upon becoming aware of any loss or theft of a Password or any unauthorized use of such Password.

5. Researcher will not edit, modify, or otherwise access any underlying software or computer code, documentation, reports or updates created by the Access System Manager or which is part of the Access System (the “Access System Software”). Researcher will not delete, obscure, or modify copyright notices and other proprietary rights notices in the Access System Software.

6. Researcher acknowledges that in connection with its access to the Access System, it may have access to certain Access System Software owned by Microsoft Corporation (the “Microsoft Product,” singularly, or the “Microsoft Products,” collectively). Terms applying to Researcher’s access to such Microsoft Products are available here.

7. Researcher agrees that the Access System Manager has the right to audit the correct usage of the Access System by the Researcher.

8. Researcher will not disclose confidential information of Sponsor, its affiliates, or the Access System Manager that is related to or contained within the Access System to any third parties without the prior written approval of the Sponsor(s) or Access System Manager, respectively, except as necessary for the purpose(s) described in the DSA.


Document Information

Document Control

<table>
<thead>
<tr>
<th>Title</th>
<th>Multi-Sponsor Environment SAS Clinical Trial Data Transparency Version 2.3 User Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>1.0</td>
</tr>
<tr>
<td>Location</td>
<td>\sso.vsp.sas.com\amd\Customers\Clinical_Trial_Data_Transparency_Multi-Sponsor_Environment_MSE\Help_and_How_Tos\CTDT_2.3\MSE_Clinical_Trial_Data_Transparency_Users_Guide_v0.9.docx</td>
</tr>
<tr>
<td>Date</td>
<td>1/19/2018 10:57 AM</td>
</tr>
</tbody>
</table>

Contacts

If you have questions regarding this document, contact one of the following individuals.

Email: Adam.LaManna@sas.com  Email: Sara.Vosinakis@sas.com
Document Owner: Adam LaManna  Project Manager: Sara Vosinakis
Office Phone: (919) 531-0452  Office Phone: (919) 531-3073

Revision History

<table>
<thead>
<tr>
<th>JIRA Ticket</th>
<th>Date</th>
<th>Version</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSE-612</td>
<td>06-JUN-2017</td>
<td>0.1</td>
<td>Robin MacBain</td>
<td>Set up version for edits.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>24-JUL-2017</td>
<td>0.2</td>
<td>Laura James</td>
<td>Edited draft version 0.2.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>28-AUG-2017</td>
<td>0.3</td>
<td>Laura James</td>
<td>Edited draft version 0.3.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>12-SEPT-2017</td>
<td>0.4</td>
<td>Laura James</td>
<td>Edited draft version 0.4.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>26-OCT-2017</td>
<td>0.5</td>
<td>Laura James</td>
<td>Finalized draft version 0.5.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>30-OCT-2017</td>
<td>0.6</td>
<td>Laura James</td>
<td>Finalized draft version 0.6.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>30-OCT-2017</td>
<td>0.7</td>
<td>Laura James</td>
<td>Finalized draft version 0.7.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>13-DEC-2017</td>
<td>0.8</td>
<td>Laura James</td>
<td>Edited draft version 0.8.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>14-DEC-2017</td>
<td>0.8</td>
<td>Laura James</td>
<td>Finalized draft version 0.8.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>11-JAN-2018</td>
<td>0.8.1</td>
<td>Laura James</td>
<td>Edited draft version 0.8.1.</td>
</tr>
<tr>
<td>MSE-612</td>
<td>19-JAN-2018</td>
<td>1.0</td>
<td>Laura James</td>
<td>Finalized version 1.0.</td>
</tr>
</tbody>
</table>